CHAPTER 12

EFFECTIVE TABLES AND FIGURES

JAMES M. CLARK

© James M. Clark, 1996
EFFECTIVE TABLES AND FIGURES

TABLE OF CONTENTS

PRESENTING DATA IN TABLES

  Parts of a Table

  Examples of Different Types of Data Tables

  The Mechanics of Preparing Tables

USING FIGURES

  Data Figures or Graphs

  Other Uses of Figures

PREPARING FIGURES IN SPSS FOR WINDOWS

  Creating the Initial Figure

  Editing the Graph
Effective Tables and Figures

Perhaps the most interesting and most important part of an empirical paper is the new information presented in the results. Theories and interpretations can vary from person to person and from one generation of scientist to the next. But despite the varied explanations, most findings remain fixed and of continued usefulness.

The results of a study can be presented in one of three ways: verbally in the text, numerically in a table, or visually in a figure (or graph). An earlier chapter on APA style discussed the presentation of results in text. This chapter describes some factors to consider in presenting results in tables and figures. Other uses of tables and figures, which are becoming increasingly important in scientific writing, are also mentioned briefly.

Several general factors should be considered in preparing either tables or figures. First, think carefully about what data to include in a table or figure and how that data can be arranged to communicate effectively the message that you want readers to gain from the paper. Tables that contain irrelevant information or that are disorganized will interfere with effective communication rather than enhance it.

A second factor to consider carefully is the necessity of all tables and figures and their relationship to the text. If you have many tables or figures, see if it is possible to reduce the number; combine those that contain repetitive or redundant data, eliminate those that are secondary or peripheral to the main findings, and translate extremely simple tables and figures into text. The APA manual, for example, suggests that a table with two or fewer columns and two or fewer rows is a good candidate for elimination. At the other extreme, very detailed tables that you want to include might be put in an Appendix rather than a table. One way to check for redundancy (and also consistency) is to examine closely a list of the titles for all your tables and figures (Woodford, 1968).

A third point relevant to both tables and figures is to keep the ultimate destination of your paper and its tables and figures clearly in mind when preparing your manuscript. In particular, journals can have different requirements for the preparation of tables and figures. So if you are preparing a manuscript for a specific journal, read the instructions to authors carefully and study the format used by that journal (i.e., examine sample tables and figures in recent articles) before
putting your own tables and figures in their final form.

**PRESENTING INFORMATION IN TABLES**

Tables are one of the primary ways to present data to readers, but other information can also be presented. Tables present information, generally data, in rows and columns. In the case of data tables, the rows and columns identify the levels of the independent variable(s) or the different types of statistics presented (e.g., mean, standard deviations, percentages). The entries in the cells of the table represent various statistical results for the dependent variable(s).

Tables are used to complement the presentation in the text, but still should be self-contained (i.e., comprehensible on their own). The APA chapter describes how to cite tables to indicate their placement in the text. For additional information on preparing tables, see the APA Publication Manual (pp. 120-141; a checklist for tables is presented on pp. 140-141), and other references presented at the end of this chapter (e.g., Day, 1994).

Tables are particularly useful when it is desirable to present exact values (Alley, 1978) and when presenting all the desired information in the text would make the paper too dense with numbers. Day (1994) suggests that tables should only be used when repetitive data *must* be presented and that whenever a table or columns within a table can be put into words, do it. Tables should be used carefully because too many tables can be difficult to follow, can interfere with the flow of text, and can increase the cost of publishing the paper. The same data should not appear in both a table and the text, although writers often select important data from a table for mention in the text. In short, tables are an efficient way to present large amounts of data in a precise manner, although caution must be used to avoid overwhelming the reader.

**Parts of a Table**

Tables can be divided into several parts or sections, including the title, headings, the body, and footnotes (see Table 12.1 and APA Manual, p. 121).
**Table 3**  
Mean Reaction Time and Errors by Age and Number of Trials

<table>
<thead>
<tr>
<th>Age</th>
<th>Number of trials</th>
<th>Reaction time (ms)</th>
<th>Percent errors</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>Young</td>
<td>410</td>
<td>395</td>
<td>372</td>
</tr>
<tr>
<td>Old</td>
<td>509</td>
<td>482</td>
<td>455</td>
</tr>
<tr>
<td>Young</td>
<td>16</td>
<td>12</td>
<td>11</td>
</tr>
<tr>
<td>Old</td>
<td>22</td>
<td>17</td>
<td>13</td>
</tr>
</tbody>
</table>

**Note.** n = 25 per group.

**Box 12.1.** Parts of a Table (in italics).

**Title.** An effective title is important if a table is to be understood independently of the text. The title should be informative and explain what information is presented in the table. The title often contains names for the dependent and independent variables. Although it is to be explanatory, the title must also be brief. Conciseness can be achieved by including primarily substantive words that convey information and by omitting unnecessary words.

Titles are sometimes used to provide information about abbreviations or other conventions in the table. For example, the title "Percent Recall by Junior Kindergarten (JK) and Grade One (G1) Children" permits the researcher to use JK and G1 as abbreviations in the table without adding a footnote as explanation. Capitalize the first letter of every content word in the title, do not end with a period, and underline the entire title.
**Headings.** Tables consist of rows and columns that define the cells of the table. Understanding the table depends on a correct interpretation of what each row and column (hence each cell) represents. Correct interpretation in turn depends on meaningful and readily-interpreted headings.

Use a brief and concise heading for each column. Headings identify the items in the column below them and not the items in the row beside each heading. The headings should be clear enough for readers to make sense of the table without any reference to the text (except perhaps in the case of very complex studies).

The actual width of the heading should be similar to the widest data entry in the column. For narrow columns that require lengthy headings, it may be necessary to stack the heading (i.e., use several narrower lines for a single heading) or reverse the rows and columns to allow more room. Headings should be parallel to one another in both content and form (i.e., syntax).

The left-most column is called the stub of the table and often will contain text that describes the condition represented by each row. The stubhead is the heading for the stub column and defines what variable is represented by the levels of the stub. In Box 12.2 the heading "Gender" is the stubhead and the entries "Male" and "Female" in the stub column identify the level of the variable that corresponds to each row.

If several levels of heading and subheading are required, indent the subheadings to indicate their level.

In Box 12.2 the label "Time of week" is called a column spanner because it spans multiple columns. The column spanner is the name of the variable and the underlying

**Table 3**

<table>
<thead>
<tr>
<th>Percent Alcohol Consumption by Gender and Time of Week</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time of week</td>
</tr>
<tr>
<td>Gender</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>Female</td>
</tr>
<tr>
<td>Male</td>
</tr>
</tbody>
</table>

**Box 12.2.** Sample of Table Stub.
column heads identify the levels of the variable. The column spanner and column heads are called "decked heads" because they are stacked above one another. In more complex tables, it may be necessary to partition the table even further. This can be done with a table spanner, which covers the entire width of the table.

Only the first letter of headings should be capitalized, as though they were sentences. Try also to keep headings as short as possible, yet still informative.

**Body of the table.** The main entries of the table appear in the body, that is, in the cells defined by the rows and columns. Try to arrange the data so that the meaning of the entries will be obvious at a glance. Thoughtful arrangement of the rows and columns, as well as effective headings, will do much to further your reader's understanding of the table.

In arranging the entries, decide what comparisons you want to emphasize to the readers. Then, if possible, arrange the table so that the to-be-emphasized comparisons occur down columns rather than across rows and no entries intervene between the to-be-compared values. It is generally easier to compare entries down columns rather than across rows. In addition to making the table easier to read, having similar elements down the rows often makes the final table more compact.

Be concise in choosing what information to include in your tables. For example, omit columns or rows that are easily calculated from other entries. Keep the arrangement of entries orderly and consistent across multiple tables.

Entries in each column should be comparable to one another. Use the same measurement units and the same number of decimals in the entire column. The precision used (i.e., the number of decimals) should be as minutely specified as is appropriate, but no more so. Rounding off values can make tables more readable and permit easier apprehension of the general pattern in the data; that is, readers do not get distracted by unimportant differences in the third or fourth decimal place.

If there are empty cells in the table, use a blank if the cell is not applicable and a dash if the cell value was either not obtained or not reported. A footnote should explain the dash (e.g., -- No subjects appeared in this cell.), except in the case of a correlation matrix (see below).

The body of the table is divided up in several ways (see Table 12.1). Horizontal lines are
used to separate major sections of the table. The only ruling should be horizontal lines; do not use vertical lines. To achieve vertical separation, use whitespace between columns. Whitespace and appropriately aligned columns will produce visually distinct columns of information. With respect to alignment, numbers should be right justified in the column and text should be left justified in the column.

When planning the width of the columns and of the table, remember again the article's possible destination in a journal. The width of each journal column is approximately 65 characters and the width of each journal page is approximately 125 characters.

Notes. It is often necessary to include footnotes with a table in order to explain quantities and abbreviations used in the table or to provide important auxiliary information (e.g., the number of subjects, significance levels). Although footnotes are used to provide additional explanatory, do not repeat excessive detail in the footnote. There are several levels or types of footnote.

A general footnote, if one is necessary, always occurs first. The contents appear immediately after the identifier Note. on the same line. Information in the general note is not attached to any particular entry in the table. General notes can be used to eliminate repetition of values in the table (e.g., a constant \(\bar{n}\) in each condition). If the table comes from another source (e.g., a published article), that source would be acknowledged with a footnote.

Specific footnotes follow the general note and are identified individually by superscript letters. The superscripts also appear in the table at the entry to which the table refers. This entry might be a heading or a cell entry, depending on the note.

Another type of footnote conveys information about probability values associated with various statistical tests. Use varying numbers of asterisks to identify the significance level, with more asterisks indicating higher levels of significance (e.g., \(* p < .05, * * p < .01, \ldots\) ). The appropriate number of asterisks would appear in the table beside the statistic (i.e., the correlation or regression coefficients, the \(t\)s or \(F\)s, or other statistics). If you must distinguish between one- and two-tailed tests, use asterisks for the two-tailed tests and varying numbers of daggers for the one-tailed tests.

Type all footnotes flush left and at the bottom of the table, as shown in Table 12.1
other examples in this chapter.

**Examples of Different Types of Data Tables**

The guidelines described above are illustrated on the next few pages with several different types of data tables that appear frequently in psychological research. For other examples, see the APA manual.

**Means.** One common type of table, especially in experimental studies, is a table of mean scores on one or more dependent variables as a function of one or more (usually more) independent variables. Box 12.3 shows a hypothetical example of a table of means. The rows comprise the levels of one independent variable (Interference) and the columns comprise the levels of the other independent variable (Age). All 9 cells defined by the three levels of Interference and the three levels of Age contain means and standard deviations for the respective condition.

<table>
<thead>
<tr>
<th>Table 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mean Number of Words Recalled by Age and Amount of Interference</strong></td>
</tr>
<tr>
<td><strong>Age (Years)</strong></td>
</tr>
<tr>
<td>20-39 40-49 50-59</td>
</tr>
<tr>
<td>Interference   M  SD  M  SD  M  SD</td>
</tr>
<tr>
<td>Low            25.6 4.3  24.9 4.5  25.3 5.2</td>
</tr>
<tr>
<td>Medium         22.3 4.2  20.5 5.0  18.7 4.3</td>
</tr>
<tr>
<td>High           20.1 3.9  15.2 4.8  11.1 5.9</td>
</tr>
</tbody>
</table>

*Note. Maximum score = 30. n = 25 per cell.*

**Box 12.3. Sample Table of Means.**
The data in Box 12.3 has been arranged to facilitate differences as a function of amount of interference (i.e., down the columns). Looking down the columns of means indicates that interference has little effect for the younger subjects and a larger effect of older subjects. It is also possible to compare age groups across the rows, but these comparisons are more difficult because they are horizontal rather than vertical and because the standard deviation columns separate the columns that we want to compare. To facilitate comparisons across age levels, the researchers could move the standard deviations (e.g., put them on intervening rows) or perhaps even remove them altogether. It would also be possible to transpose the row and column variables so that the age comparisons involved values arranged vertically. The data in Box 12.3 might also better be presented as a figure, as demonstrated later.

Although tables should not contain values that are easily calculated from other rows or columns, examining tables of means is sometimes simplified by including column and row averages. Table 12.3, for example, could have included overall means for each age level and/or each level of interference. Including this additional information might require that the standard deviations be eliminated so that the table did not become overly complex. Row and column means can provide useful comparisons for interpreting the cell values.

Another convention that is sometimes found in tables of means is the use of lowercase subscripts to indicate significant differences between means, as determined by some appropriate multiple comparison procedure. Means in a row or column that do not differ significantly are given the same subscript. The meaning of the subscripts would be explained in the general note to the table (e.g., Note. Means in the same column that do not share subscripts differ at $p < .05$ using the Student-Newman-Keuls procedure.).

In studies that involve more than two independent variables, it is necessary to divide the table into additional sections or stack the levels of the independent variables. Box 12.4 shows a hypothetical table with three independent variables. The levels of the third variable are captured by dividing the table horizontally into two sections using a table spanner (i.e., the Verbal and Mathematical tests).
Table 2

Percent Correct on Verbal and Mathematical Tests by Grade Level and Gender

<table>
<thead>
<tr>
<th>Grade</th>
<th>Gender</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Girls</td>
<td></td>
<td>34.65</td>
<td>46.23</td>
<td>66.92</td>
</tr>
<tr>
<td>Boys</td>
<td></td>
<td>30.23</td>
<td>40.95</td>
<td>58.25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32.13</td>
<td>44.85</td>
<td>64.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35.22</td>
<td>47.48</td>
<td>70.10</td>
</tr>
</tbody>
</table>

Note.  \( n = 25 \) participants in each group.

Box 12.4. Example of more complex table.

**Correlation tables.** A second commonly-occurring type of table is the correlation matrix, which shows the correlations between a number of variables. Each variable is represented by a row and a column in the table. The correlation between two variables appears in the cell defined by the intersection of their respective rows and columns. Box 12.5 shows an example of a correlation table.
Note several features of the correlation table. First, it is only necessary to show the values above (or below) the diagonal because the corresponding cells above and below the diagonal contain the same value. That is, the correlation of x with y is the same as the correlation of y with x. Second, it is not necessary to report the correlation of a variable with itself, so dashes appear in those cells. Footnotes are not required to explain these dashes in correlation tables.

In particularly complex correlation tables, researchers will sometimes omit the decimal value. It is redundant inasmuch as researchers know that the correlation coefficient can only vary between -1.0 and +1.0. When decimals are omitted, include a footnote to explain the omission.

**ANOVA and regression tables.** The APA manual provides examples of other kinds of tables, such as those that summarize ANOVA and regression analyses. Although once common in psychology journals, ANOVA summary tables appear quite rarely now. Relevant statistics ($F$s, $MSE$s, and $p$s) are presented in the text (see Chapter 11) and means (and sometimes standard deviations) appear in tables as described above or as figures. For regression analyses, tables are often used to summarize the results for individual predictors and the overall regression, especially when predictors are entered in a successive manner (e.g., hierarchical regression).

**Tables of text.** The preceding discussion has emphasized the use of tables to present the results of studies, that is, data. Tables can also be effective for presenting certain kinds of text. Outlines, summaries, and lists are often easier to comprehend when presented in a concise form.
rather than in full sentences, which is what standard text requires.

Box 12.6 illustrates the use of a table to summarize the factors that researchers should consider in preparing tables for a manuscript. The table presents material in a concise and memorable way that would be difficult to achieve in text. These kind of text tables can be particularly useful when planning a conference presentation or poster (see Chapter 12).

When typing tables, doublespace the table throughout, just as the main text in your manuscript is doublespaced. The space makes the table more attractive and readable, and is also needed for editorial notes during the publishing process.

**The Mechanics of Preparing Tables**

Tables can generally be prepared using any contemporary wordprocessor, such as Microsoft Word or Wordperfect. There are only a few “tricks” that need to be discovered in order to prepare professional looking tables.

**Aligning numbers on the decimal.** In preparing tables with data (e.g., means, correlations), it is desirable to line the numbers up vertically according to the decimal value. In Boxes 12.4 and 12.5, for example, the means and correlations are aligned by decimal. This would be particularly important if the numbers were both positive and negative in value (i.e., to accommodate the negative sign), or if the numbers had different numbers of digits before the decimal. There are two approaches to this issue. One approach is to use a Fixed font (e.g., Courier), which is a font that uses exactly the same width for every character in the font set. That makes it possible to use spaces (which are the same width as other characters) to align the numbers perfectly. This approach works less well if numbers or other characters appear as subscripts or superscripts, because these characters are smaller than standard widths.
A more general and preferred approach is to use wordprocessor features to align numbers on the decimal value, rather than on the first character. In Wordperfect, for example, this feature appears as a Decimal Tab command accessed by the Format | Line | Other Codes menu path. In Word, Decimal Tabs can be accessed through Format | Tabs.

**Trouble-shooting codes.** Sometimes it is difficult to figure out why your table does not appear exactly the way that you want. One elegant feature available in Wordperfect, but not Word, is the ability to reveal the formatting codes that are inserted into the document. When reveal codes is turned on by View | Reveal Codes or by <Alt>F3, the screen splits and part of the screen will show both the text and the (normally) hidden codes (e.g., tabs, centering, font changes, ...). This makes it easier to find the cause for any unexpected appearances of your table (or of your document more generally).

**USING FIGURES**

The common saying that "A picture is worth a thousand words" has considerable truth for researchers. There are many situations in which verbal descriptions become clumsy or completely impractical for the presentation of data. Moreover, even when a verbal description is possible, the text may not convey very clearly the particular pattern of results. These limitations of verbal communication can sometimes be overcome by the use of visual methods (i.e., figures). The principal use of figures in Psychology is the presentation of results (i.e., graphs), but other uses are increasing in frequency and are described briefly later in the chapter.

**Data Figures or Graphs**

Data figures (commonly called graphs) use symbols, lines, text, and spatial relations (i.e., space or geometry) to summarize research results. Graphs often convey information about relationships between one or more independent variables and one or more dependent variables. Graphs are preferred to tables when the general pattern of results is more important than the exact values. The specific form of a graph varies somewhat with the kind of variable (e.g., whether the predictor is a randomly varying nonexperimental variable or an evenly distributed experimental variable).
**Box 12.7** shows the basic features of the most commonly used figure in experimental research, a line graph of means plotted against one or more independent variables. The italicized labels and the arrows are not part of the figure, but are included here to label elements that occur in figures. Such graphs are in essence visual depictions of the tables of means that were discussed earlier in this chapter. The data in Box 12.7, for example, is the same data that was presented in the table of Box 12.3. Note that Box 12.7 is missing an important element, a label for the vertical axis!

Designing effective line graphs involves decisions about many factors; see references at the end of this chapter for some excellent books and articles on graphing data. The range of values on the horizontal and vertical axes should be selected so as to fill up most of the data region. Do not leave excessive amounts of blank space in the figure. It is not necessary to always include the zero values for the axes, although some authors still recommend the inclusion of both zeros with a break in the axes when steps are omitted. Try to keep scales constant across multiple figures that will be compared to one another.

Once the scales have been selected, decided on the axis labels and tick marks. Use regular values and steps (e.g., 2, 4, 6; 5, 10, 15; 10, 20, 30;) that start somewhere below the
lowest value and end somewhere close to the maximum value. Tick marks can be placed inside or outside the axis, although ticks placed outside may interfere less with or distract from the data.

Decide next about any symbols and lines to be used in your figure. The most standard symbols are circles, triangles, and squares that are either empty or filled. However, mnemonic letters are sometimes used (e.g., C for control group and T for treatment group). Various styles of line can be used (e.g., solid line, dotted line, dashed line, and various combinations). Do not get too fancy. Different symbols and line styles should both be used only when they represent different variables. In a two-by-two factorial study, for example, one variable might be represented by open and closed circles and the other variable by solid and dashed lines. The four combinations would define the cells of the factorial.

All of the graphical elements (symbols, lines, text) should stand out clearly and be distinctive. Clarity depends on several factors, but primarily size. Use substantial symbols, thick lines, and a large enough point size for text. The font that you select should be a tidy one (i.e., sans serif). Distinctiveness is particularly important for symbols or lines that encode different levels of your conditions. For example, readers could have great difficulty interpreting a figure with open boxes and circles that define different conditions if the boxes and circles are not easily distinguished from one another. Similarly, letters used as symbols should not be confusible with one another. In preparing figures for publication, remember that they will be reduced for publication, which will affect the clarity and distinctiveness of the original elements.
Bar graphs.

Researchers sometimes use bars instead of symbols and lines to represent the means in a figure. Box 12.8 shows the data from Box 12.7 as a bar graph. The height of the bar corresponds to the mean value on the vertical axis (again the label is missing). The horizontal axis represents levels of one independent variable and different patterns or shadings within the bars represent different levels of a second independent variable, or more in complex designs.

Many of the considerations discussed in creating line graphs also apply to bar graphs (e.g., use of space, scaling of axes). One new factor is the selection of fill for the bars. As with the selection of symbols and lines, choose fill patterns that are readily discriminable from one another and, if possible, that map onto the nature of variable being encoded (e.g., increasing intensity of fill with increasing magnitude of the independent variable). The fill patterns in Box 12.8, for example, could have been selected from some ordered attribute.

A number of strange perceptual effects can occur with combinations of different line patterns (e.g., oblique lines in different orientations within the same figure), so examine carefully the visual impression of your bar graphs. Select fill patterns that are easily discriminable, ordered appropriately, and do not produce unusual visual effects (unless that is your goal).
The choice of line graph or bar graph has sometimes been made on the basis of whether the dimension along the horizontal axis is numerical or categorical. Specifically, line graphs have been recommended for numerical independent variables and bar graphs for categorical independent variables. Ultimately, however, the decision should probably be made more on the basis of which format best communicates the results of the study. Some research suggests that people find it easier to identify patterns in line graphs than in bar graphs.

**Other Uses of Figures**

There are many other uses of figures besides the presentation of data, and these additional uses are becoming increasingly common in psychology. One reason visualization methods are becoming more common is the growing complexity of the phenomena and models that psychologists try to explain. Many complex events can be communicated far more effectively by a picture than by words.

*Theoretical models.* You have probably come across numerous examples of figures that summarize theoretical models for psychological phenomena. One classic example is Maslow's hierarchy of needs, which has been depicted as a pyramid with basic needs at the bottom and self-actualization needs at the top. Such use of figures is growing as psychologists become more mechanistic and precise about their theories (Butler, 1993).

Box 12.9 shows an example of one theoretical model of the cognitive processes involved in writing. This model was discussed more fully in the chapter on writing. With respect to its graphic qualities, boxes represent functional elements or

**Box 12.9.** Figural Representation of a Theory of Writing.
processes within the entire system and arrows represent transmission of information from one stage to another or causal influences of one processing element on other elements.

**Causal models.** As the number of variables and relationships increase, it can become very difficult to verbally describe all of the causal links between the variables. One efficient way to characterize these hypothetical or empirically-determined relationships is by means of a causal model in which names (within some shape or not) identify the variables and lines (with or without arrows) depict the causal relationships.

**Apparatus and methods.** Figures are also used to illustrate complex apparatus or the sequence of events in a complex study. A figure may be more parsimonious and/or more effective in conveying an accurate impression of what was actually done in the study.

Box 12.10 shows a simple example of how a visual representation can be used to describe the sequence of events in a hypothetical cognitive study. The figure readily communicates the sequence of events and the timing for each, something that might be quite difficult to do in words.

**Statistical assumptions.** Another use of figures is statistical in nature, but differs from the uses emphasized above (i.e., the description of the results). Researchers often use figures of various sorts to examine the assumptions that underlie their statistical tests. Linear correlation and regression procedures, for example, assume that the dependent variable changes linearly as a function of the independent variable(s). If the relationships are nonlinear, then linear analyses can be quite misleading; that is, researchers might wrongly conclude that there is no relationships between the variables. Plotting a scattergram of the data (as described above) or plotting the

<table>
<thead>
<tr>
<th></th>
<th>Duration (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mask</td>
<td>&amp; &amp; &amp;</td>
</tr>
<tr>
<td>Prime</td>
<td>Nurse</td>
</tr>
<tr>
<td>Mask</td>
<td>&amp; &amp; &amp;</td>
</tr>
<tr>
<td>Blank</td>
<td></td>
</tr>
<tr>
<td>Target</td>
<td>Doctor</td>
</tr>
</tbody>
</table>

Box 12.10. Sequence of Events in a Single Trial.
residual scores against the predictor variables will reveal any nonlinearity in the data. It is rare, however, that such figures would be included in the actual paper, unless they represented the primary purpose of the research.

**PREPARING FIGURES IN SPSS FOR WINDOWS**

Creating an effective figure was once a time-consuming and expensive job that involved artists who specialized in scientific art. Today, however, many computer programs (e.g., spreadsheet programs, statistical packages) will create graphs and other figures that are suitable for classroom and presentation purposes. Some of the packages are powerful enough to prepare excellent figures for publication. Special purpose programs, such as Harvard Graphics and Wordperfect Presentations (formerly Drawperfect), include numerous options for controlling the characteristics of different types of figures. Many of the figures created in this chapter were done with an older version of Drawperfect.

Statistical packages also have graphing capabilities. SAS, for example, includes several powerful graphing procedures that can be used to create effective graphs. The standard SPSS package on Unix has some crude graphing capabilities, and the Windows version, discussed more fully below, is much more powerful. Whatever program you use to create graphs, be sure to explore its full potential. The specialized programs have many options and it is not always intuitively obvious how to access them nor what parameters of the figure they control. We will illustrate the process using SPSS for Windows.

The following assumes that the data have been entered in SPSS. The “data” in this case can be the raw data, with SPSS doing the computations for the following figures. In some situations, however, SPSS may not “organize” the data in the manner that the user wishes for the figure (e.g., treatment of within-S factors may not allow the desired line graph). One approach that often works in such situations is to enter the means (or other desired statistics), along with indicator variables for the levels of the factor(s) against which the means are to be plotted.

**Creating the Initial Figure**

Once data has been entered into SPSS for Windows, it is possible to request various types of figures (or graphs), including two- and three-dimensional scattergrams, bar charts, and line graphs. Most of the other types of graphs in SPSS are of more interest to people in business than
to scientists. Below we consider some of the more common types used in psychology.

It is possible to create graphs using Syntax, the pull-down Graphics menu, or Interactively. We will focus on using the menus, but if you have syntax printed to the output file, you will see how the commands could be specified in a syntax file. The various graphing formats are accessed from the Graphs menu.

**Simple scattergram.** To produce a simple scattergram, select Graph | Scatter to open the Scatterplot window, select the Simple plot, and click on Define. Select the appropriate variables in turn and click on the appropriate arrow to define the independent and dependent variables. Click on OK to execute the command.

**Three-dimensional plot.** Again select Graph | Scatter to open the scatterplot window, select the 3-D plot, and click on Define. Select one variable and click on the arrow to enter that variable as the dependent (vertical) variable. Do the same to move x into X and z into Z. Click on OK to execute the command.

**Line graph.** Select Graph | Line to open the Line graph window, choose Simple or Multiple, depending on whether there is one or two independent factors to be plotted, and Define. Again specify the dependent and independent variable(s) and then OK to create the graph. Line (and sometimes Bar) graphs are the most common types of graphs for studies analyzed by ANOVA.

**Editing the Graph**

The initial graphs in SPSS will generally be quite primitive (e.g., simple variable names on the axes). Once the graph has been created, however, it is possible to double-click on the graph to invoke the Chart Editor. The Chart and Format menus access the functions needed to edit the graph.

**Chart menu.** The Chart menu gives access to various aspects of the figure, including Axis, Legend, Annotation, Options, and Outer, and Inner frames. From the Axis option, choose which axis to modify (horizontal or vertical), and then set the appropriate options for: title, justification (usually centered), the range of values (enough to accommodate values, but not excessive), increments (reasonable number of some even multiple), labels (decimals, orientation), and gridlines (whether lines appear across the graph at increments).
option allows one to modify the contents of the legend, locate it at the appropriate position, or turn it off if lines are labelled in another manner. One effective way to label lines is using the Annotation option, which allows text to be placed at different locations on the figure (e.g., Group 1 by the appropriate line). Options include aspects of the graph that vary across types of graphs. In 3-D graphs, one can include spikes from data points to the floor and control the format of the wireframes that define axes. For scattergram, Options can be used to Fit Linear or Quadratic (i.e., nonlinear) functions. The Chart menu also allows the Outer and Inner frames to be turned on or off (usually off in scientific graphs).

Format menu. The Format menu changes features of the graph. Make changes by selecting an object to modify (e.g., a symbol, text, or line), selecting what change to make from the Format submenu (e.g., Marker, Line, Text, Color), and then applying the change. Marker modifies symbols and their size; note that for Line graphs, markers are not displayed until Interpolation and Display Markers is selected. Text modifies the font and its size, and Line modifies style (e.g., solid or dashed) and thickness. For 3-D figures, Rotation rotates the figure.

Working with the Graph

Once the graph has been created, there are a number of operations that might be performed on it. Within the chart editor, users can Export the graph in various formats using the File menu, and they can Copy Chart from the Edit menu. The copied or exported figure could then be pasted or imported into another file (e.g., a Word or Wordperfect document). File | Close will return to the main SPSS output screen. In the main output screen, it would be possible to select and Print the figure, and to save it as part of the output.

CONCLUSION

The area of scientific visualization is changing rapidly at the present time. Computers now permit kinds of visualization that were extremely difficult, expensive, and even impossible not too many years ago. For example, dynamic displays on computer screens can reveal aspects of the data that might be difficult to apprehend from static displays or from standard statistical analyses. Perhaps the basics of representing data in tables and especially figures, as presented in this chapter, will encourage you to examine more sophisticated ways to examine the pattern of results in psychological studies that you undertake as a student.
REFERENCES


